
set up your limiting. 
 
Throttle Speed determines the percentage of full 
speed that is applied to the throttle movements 
that are above the throttle trigger setting. 100 is 
maximum servo movement rate. 1 is minimum 
rate. Default is 100 (full speed). 

 
Brake Speed determines the percentage of full 
speed that is applied to braking movements that 
are above the trigger setting. 100 is maximum 
servo movement rate. 1 is minimum rate. Default 
is 100 (full speed). 

 
Throttle Trigger sets the minimum amount of 
control input before the speed limiter becomes 
active. At 0%, limiting is always active (input is 
always >= 0%). At 50%, limiting is only active if 
the throttle is on half way or more. 

 
Brake Trigger sets the minimum amount of 
control input before the speed limiter becomes 
active. At 0%, limiting is always active (input is 
always >= 0%). At 50%, limiting is only active if 
the brake is on half way or more. 

 

 



Changing the Throttle Speed 
 

Use the navigation controls to change the steering servo type as follows: 

1. Access the top function menu from 
the driving screen. 

 

2. Navigate to the Steering (Ch1) menu. 
  or      then   

3. Navigate to Throttle Speed. 
 or   

Value Description 

Throttle 
Speed 

The amount of limiting applied to servo throttle 
motion  once the trigger amount has been exceeded. 4. Change the values. 

 or  
Brake 
Speed 

The amount of limiting applied to servo brake 
motion once the trigger amount has been exceeded. 
 

  Throttle 
Trigger 

The percentage of full throttle range that will be 
limited.  
 

  Brake 
Trigger 

The percentage of full braking range that will be 
limited. 

Interaction with other Settings 
Servo Speed is applied after Expo. The trigger levels refer to the curved input value. 
ABS is applied after Brake Speed, so Brake Speed can limit how quickly the brake input moves to the 
ABS Active region, but once there ABS pulses happen at full speed.  
Servo Speed is applied after AutoStart, so if the AutoStart Level is set higher than the Throttle Speed 
Trigger, the servo movement will be slowed.  
Idle Up only takes effect when the trigger is centered. Throttle Speed can slow down the return to 
center, and therefore slow down Idle Up activation. Once Idle Up is started, the servo will jump to the 
set position.  

Channel 3 and Channel 4 Servo Functions 
Each of these servos can be used as a number of auxiliary functions such as shifting or acting as a 
second braking or steering servo.  The following illustration shows the function menu structure for 
Channel 3 (Shift) and Channel 4 (Power):  

 

 

 



Channels 3 / 4 Servo Trim 
 

 Channel 3 and Channel 4 servo 
trim adjusts the resting 
(centered) positions of the 
servos.  
 
When initially setting up the 
vehicle, the shift servo trim 
setting should be set to 0. On the 
servo, the servo horn should be 
positioned as appropriate on the 
servo.  

 

 

On the driving screen, Channel 3 
and Channel 4 servo trims are 
represented by the position of the 
pointers on the bottom bars. 

Ch3 and Ch4 Trims

 

Changing the servo trim has the following visual effect on the driving screen bars: 
 

 Servo trim is centered in range (value = 0) 
 

 
Servo trim is offset to high end (+ve value) 

 Servo trim is offset to low end (-ve value) 

Adjusting Channel 3 / 4 Servo Trims 
Use the navigation controls to adjust shift servo trim as follows: 

1. Access the top function menu 
from the driving screen. 

 

2. Navigate to the Channel 3 or 
Channel 4 menu.    or      then   

3. Navigate to Trim. 
 or   

Value Description 
0 Shift servo trim is centered within the 

servo range. 
-ve value 

(-100  -1) 
Shift servo trim is to the LOW end. 4. Change the value. 

 
or  

 

+ve value 
(1  100) 

Shift servo trim is to the HIGH end. 

 



Trim and EPA Interaction 
A trim (or sub-trim) setting of 100 is equivalent to an End point setting of 50. 
 

 
 

 
 

 
 

 
 

Channel 3 / 4  Servo Dual Rate 

 

Channel 3 and Channel 4 servo 
dual rates adjust the range of 
servo movement when the grip 
buttons are activated. The servo 
dual rate value is applied to both 
low and high ends, and is 
expressed as a percentage of 
servo range (configured by end 
point adjustments). 

 

 

On the driving screen, servo dual 
rate range is represented by the 
solid length of the bottom bar. 
The total length of the bar (solid 
and dotted) represents the servo 
range. The length of the solid bar 
represents the servo range as set 
by the dual rate value. 

Ch3 / Ch4 Dual Rate Ranges

 

Changing the dual rate setting has the following visual effect on the driving screen bars: 

Full servo range is used. 

 Lower dual rate value reduces servo range. 

Adjusting Channel 3 /4 Servo Dual Rate 
Use the navigation controls to adjust servo dual rate as follows: 

1. Access the top function menu 
from the driving screen. 

 

2. Navigate to the Channel 3 or 
Channel 4 menu.   or      then   



3. Navigate to Dual Rate. 
 or   
Value Description 

0 Servo range is set to minimum (0%). 

1-99 Servo range is set to a percentage of full range. 
For example, value “50” gives 50% of full servo range. 

4. Change the value. 

 or  100 Servo range is set to full (100%) 
 

Dual Rate and End Point Adjustment 
Full servo range is determined by the shift servo low and high end point adjustments. The dual rate 
value determines the relative servo range between the low and high end points. The servo will never 
move beyond the set end point adjustments, no matter what dual rate setting is applied.   

Low End Point 

 

The servo low end point value 
adjusts the shift servo’s starting 
position at reset. This is intended 
to be low gear and goes with the 
downshift sound event (reverse 
the servo if this is not the case on 
your model). The end point 
adjustments should be adjusted 
prior to other settings. 
 
The low end point is set 
independently of the high end 
point (which adjusts how far the 
servo moves to the HIGH end). 

 

 

On the driving screen, the low 
end point is represented by the 
length of the bar to the left of the 
pointer on the lower bar. The 
greater the left length of the bar, 
the greater the low end point 
value. 
 

The position of the pointer on the 
bar is affected by end point 
settings (low and high) and trim 
setting. 

Ch3 / Ch4 Low End Points

 

 Low end point value is approximately the same as 
the high end point value. 



 Increased low end point value (more servo travel 
on LOW end is possible). 

 Decreased low end point value (less servo travel 
on LOW end is possible). 

The position of the pointer on the bar is affected by end point settings (low and high) and trim setting; 
increasing the low end point value may visually appear to have the same effect as decreasing the high 
end point value. 

An end point setting of 100 (the default) is typical for most servos, and should always be used for 
ESCs. Larger setting values will overdrive most servos 

Adjusting the Low End Point 
The low end point value is a relative value, and is expressed as the percentage of full travel to the LOW 
end. 
Use the navigation controls to adjust the low end point as follows: 

1. Access the top function menu from 
the driving screen. 

 
2. Navigate to the Channel 3 or 
Channel 4 menu.   or      then   

3. Navigate to Low End Point. 
 or   

Value Description 

0 Minimum low end point; allows NO travel to low end. 

1-199 Low end point value is set to a percentage of travel 
range to low end. 

4. Change the value. 

 or  200 Maximum low end point (will overdrive most servos) 
 

 
 
Trim and EPA Interaction 
A trim (or sub-trim) setting of 100 is equivalent to an End point setting of 50. 
 

 
 

 
 

 
 

 



 

 
 

 
 

 
 

 
 

 
 

High End Point 

 

The shift servo high end 
point value adjusts the 
servo’s ending position 
after shifting upwards. 
This is intended to be 
high gear and goes with 
the upshift sound event 
(reverse the servo if this 
is not the case on your 
model). The end point 
adjustments should be 
adjusted prior to other 
settings. 
 

The high end point is set 
independently of the low 
end point (which adjusts 
how far the servo moves 
to the LOW turns end). 

 

 

On the driving screen, 
the high end point is 
represented by the 
length of the bar to the 
right of the pointer on 
the upper bar. The 
greater the right length 
of the bar, the greater the 
high end point value. 

Stee

Thro

Shift

Ch4

Ch3 / Ch4 High End Points

 



 

The position of the 
pointer on the bar is 
affected by end point 
settings (low and high) 
and trim setting. 

Changing the high end point value has the following visual effect on the driving screen bars. 

 High end point value is approximately the same as 
the low end point value. 

 Increased high end point value (more servo travel 
on HIGH end is possible). 

 Decreased high end point value (less servo travel 
on HIGH end is possible). 

The position of the pointer on the bar is affected by end point settings (low and high) and trim setting; 
increasing the high end point value may visually appear to have the same effect as decreasing the low 
end point value. 
An end point setting of 100 (the default) is typical for most servos, and should always be used for 
ESCs. Larger setting values will overdrive most servos 

Adjusting the High End Point 
The high end point value is a relative value, and is expressed as the percentage of full travel to the 
HIGH end.  
Use the navigation controls to adjust the high end point as follows: 

1. Access the top function menu from 
the driving screen. 

 
2. Navigate to the Channel 3 or 
Channel 4 menu.   or      then   

3. Navigate to High End Point. 
 or   
Value Description 

0 Minimum high end point; allows NO travel to high end. 

1-199 High end point value is set to a percentage of travel 
range to high end. 

4. Change the value. 

 or  
200 Maximum high end point (will overdrive most servos) 

 

Trim and EPA Interaction 
A trim (or sub-trim) setting of 100 is equivalent to an End point setting of 50. 

 



Channel 3 / 4 Dual Rate Mode 
 

 

Dual Rate Mode controls the behavior of the Dual 
Rate setting for the channel 3 and channel 4 
servos. 

Changing the Channel 3 / 4 Dual Rate Mode 
Use the navigation controls to change the dual rate mode as follows: 

1. Access the top function menu 
from the driving screen. 

 

2. Navigate to the Channel 3 or 
Channel 4 menu.   or      then   

3. Navigate to DR Mode. 
 or   

Value Description 
Both Dual rate affects travel in both direction 

Throttle 
Dual rate affects throttle travel only. Useful to limit 
throttle inputs early in a run with an electric model. Only 
meaningful if the servo mode is Thr/Brake. 4. Change the value.  or  

Brake 
Dual rate affects brake travel only. Useful to adjust 
brakes on a nitro vehicle without affecting throttle travel. 
Only meaningful if the servo mode is Thr/Brake. 

 

 

Channel 3 /4 Servo Reverse 

 

Servo reversing reverses the 
direction the shift servo moves 
upon receiving an input from the 
grip buttons. 

 

Changing the Channel 3 / 4 Servo Reverse Setting 
Use the navigation controls to change the servo reverse setting as follows: 

1. Access the top function menu 
from the driving screen. 

 
2. Navigate to the Channel 3 or 
Channel 4 menu.   or      then   



3. Navigate to Servo Reverse. 
 or   

Value Description 
Off Standard servo direction. 4. Change the value. 
On Reversed servo direction. 

 

 
 

 
 

 
 

Channel 3 / 4 Servo Type 

 

Servo type lets you select the type of servo 
(analog or digital) in the vehicle. Analog servos 
are sent signals at 50 frames/sec, while Digital 
servos are sent signals at 100 frames/sec. 
 

If you are running an electric car with an ESC, it 
may perform better with the digital setting. Some 
ESCs may not operate at all with the higher frame 
rate. Try both settings and choose the best 
performance. 

Changing the Channel 3 / 4 Servo Type 
 

Use the navigation controls to change the shift servo type as follows: 

1. Access the top function menu from 
the driving screen. 

 

2. Navigate to the Channel 3 or 
Channel 4 menu.   or      then   

3. Navigate to Servo Type. 
 or   
Value Description 
Analog Shift servo is analog. 4. Change the value. 
Digital Shift servo is digital. 

 



Channel 3 / 4 Servo Model 

 

Shift servo mode controls the behavior of the 
channel 3 and channel 4 servos. 

 

Changing the Channel 3 / 4 Servo Mode 
Use the navigation controls to change the servo mode as follows: 

1. Access the top function menu 
from the driving screen. 

 

2. Navigate to the Channel 3 or 
Channel 4 menu.   or      then   

3. Navigate to Mode. 
 or   

Value Description 
Off No action; shift servo stays at trim position. 

Toggle 
Shift servo starts at Low. Pressing the grip button moves 
the shift servo to High. Releasing and pressing the grip 
button again moves the shift servo back to Low. 

Hold 
Servo starts at Low. Holding the grip button moves the 
shift servo to High. Releasing the grip button moves the 
servo back to Low. 

4. Change the value. 

 or  

4WS 4-wheel steering mode. Shift servo output is controlled by 
the steering wheel, just like the steering servo. 

  Thr/Brake Throttle/Brake mode. Shift servo output is controlled by 
the trigger, just like the Throttle servo 

 

 

 

 

 
Note: In 4WS or Thr/Brake mode the settings on this screen (End Points, Dual Rate, Trim, Reverse, 
Type, and Servo Speed) still take effect.  However, the Expo setting from the master channel is also 
used.  For Thr/Brake mode, Auto Start, Idle Up, and ABS also apply. 



Channel 3 / 4 Servo Speed 

 

Input/Throttle Speed determines the percentage of 
full speed that is applied to the throttle movements 
that are above the throttle trigger setting. 100 is 
maximum servo movement rate. 1 is minimum 
rate. Default is 100 (full speed). 
 
Return/Brake Speed determines the percentage of 
full speed that is applied to braking movements 
that are above the trigger setting. 100 is maximum 
servo movement rate. 1 is minimum rate. Default 
is 100 (full speed). 

 
 

 

 

Trigger sets the minimum amount of control input 
before the speed limiter becomes active. At 0%, 
limiting is always active (input is always >= 0%). 
At 50%, limiting is only active if the throttle is on 
half way or more. 
 

Brake Trigger sets the minimum amount of 
control input before the speed limiter becomes 
active. At 0%, limiting is always active (input is 
always >= 0%). At 50%, limiting is only active if 
the brake is on half way or more. 

Shift Servo mode set for 4WS Shift Servo mode set for Thr/Brake 
Input/Throttle Speed acts as Input Speed 
Return/Brake Speed acts as Return Speed 

Trigger acts as Trigger 

Brake Trigger is not used 

Input/Throttle Speed is Throttle Speed 
Return/Brake Speed acts as Brake Speed 

Trigger acts as Throttle Trigger 

Brake Trigger acts as Brake Trigger 

Changing the Channel 3 / 4  Servo Speed 
Use the navigation controls to change the steering servo type as follows:  

1. Access the top function menu 
from the driving screen. 

 
2. Navigate to the Channel 3 or 
Channel 4  menu.   or      then   

3. Navigate to Throttle Speed. 
 or   



Value Description 

Input/Throttle 
Speed 

The amount of limiting applied to servo throttle 
motion once the trigger amount has been 
exceeded. 4. Change the values. 

 or  
Return/Brake 

Speed 

The amount of limiting applied to servo brake 
motion once the trigger amount has been 
exceeded. 
 

  Trigger 
The percentage of full throttle range that will be 
limited.  
 

  Brake Trigger The percentage of full braking range that will be 
limited. 

 

 

Interaction with other Settings 
Servo Speed is applied after Expo. The trigger levels refer to the curved input value. 
ABS is applied after Brake Speed, so Brake Speed can limit how quickly the brake input moves to the 
ABS Active region, but once there ABS pulses happen at full speed.  
Servo Speed is applied after AutoStart, so if the AutoStart Level is set higher than the Throttle Speed 
Trigger, the servo movement will be slowed.  
Idle Up only takes effect when the trigger is centered. Throttle Speed can slow down the return to 
center and therefore slow down Idle Up activation. Once Idle Up is started, the servo will jump to the 
set position.  

Advanced Features  
The following illustration shows the function menu structure for the advanced functions: 
 

 

 

 
 

 
 

 
 

 
 

 
 



 

 
 

 

Advanced

Events

Idle Up

Auto Start

Antilock Brakes

Failsafes

Tach

Stat Rotate

Tank Mode  
Events  

 

The Events menu is where you control the 
feedback and alerts that the React delivers to you, 
based on Reacts and user actions. 
 

Note that you configure the actual vibration 
patterns which are triggered by these events 
through the Digital RC Desktop software on your 
PC.   

 
Some events have an alert setting that controls 
how the React alerts you when that event occurs. 
 

Each event also has a level, which controls what 
trigger sets off the event.  The meaning of the 
level setting varies with each event, and is 
documented in the table below. 

Event Summary 
 

For each Event, the “Affects” column shows which Vibration Patterns and Sounds in the RC Desktop 
are tied to that event. 

The units for Speed and Temperature are based on the Units setting in the Controller setup menu. 

Event Level Default Affects Description 



TX Battery (0.0– 10.0 volts)  
   
 

4.1 volts Vibe: TxBat Vibe Low Transmitter battery 
voltage warning 

Car Battery Car (0.0 – 20.0 volts) 
   

7.0 volts Vibe: CarBat Vibe Low car battery voltage 
warning 

RX Battery RX (0.0 – 10.0 volts) 
   

4.1 volts Vibe: RXBat Vibe Low receiver battery 
voltage warning 

Temperature (0-450 degrees) 270 degrees Vibe: Temp Vibe Over-temperature 
warning.  One level for 
each temperature sensor 
port (4 total) 

Speed (0-200) 55  Vibe: Temp Vibe Speed threshold 
notification 

Connection N/A  Vibe: Connect Vibe, 
Disconnect Vibe 

Notification when 
connecting to or 
disconnecting from 
transceiver 

Alert Over N/A  Vibe: Alert Over Vibe Notification when a 
sensor returns to normal 
operating range after an 
alert 

Startup N/A  Vibe: Startup Vibe Action at power-up, 
during splash screen 
display 

Menu N/A   
Vibe: Click Vibe, Save 
Vibe, Prompt Vibe 

Notification when 
navigating through menu 
system, clicking keys 
and saving settings 

Shift N/A   
Vibe: Shift Vibe 

Notification when the 
shift (grip) button is 
pressed 

Trim N/A   
 

Notification when user 
adjusts the trim positions 

 

Idle Up  

 

Idle Up changes the throttle servo position when 
the trigger is centered, it has no affect at other 
trigger positions. When Idle Up -> Active is On 
and the trigger is centered, the throttle moves to 
Idle Up -> Level percent. This is typically used to 
warm up a nitro engine by running it at high idle 
(just shy of the clutch engaging). 

Configuring Idle Up 
Use the navigation controls to configure Idle Up as follows: 

1. Access the top function menu from the driving 
screen. 

 

2. Navigate to the Advanced menu. 
  or       then   



2. Navigate to the Idle Up submenu. 
  or       then   

Value Description 

Active Controls whether the Idle Up feature is 
being used 4. Change the values. 

 or  
Level 

The position (-100 to +100) to which the 
throttle should go when idling 
 

 

AutoStart 
 

 

 

 

Configuring AutoStart 
Use the navigation controls to configure AutoStart as follows: 

1. Access the top function menu from the driving 
screen. 

 

2. Navigate to the Advanced menu. 
  or       then   

2. Navigate to the Idle Up submenu. 
  or       then   

Value Description 
Armed Enables or disables the AutoStart function 

4. Change the values. 

or  
Level 

The position (1 to +100) at which the 
throttle is to be maintained during AutoStart 
 

  Trigger The percentage of trigger pull (1-100%) at 
which AutoStart engages 

 

Antilock Braking System (ABS)  

 

React supports ABS brakes to give better traction 
during stopping. 

Configuring ABS 
 



Use the navigation controls to configure ABS as follows: 

1. Access the top function menu from the driving 
screen. 

 

2. Navigate to the Advanced menu. 
  or       then   

3. Navigate to the ABS submenu. 
  or       then   

Value Description 
Active Enables or disables ABS 

Trigger 

A percentage (1-100%, default 
50) indicating the braking 
threshold above which ABS is 
triggered 

Delay 

The time in seconds (0.0-2.0, 
default 0) the brake must be 
above the trigger level before 
ABS engages 

Depth 

A percentage (1-100, default 50) 
indicating the reduction in 
braking force during the ABS 
coast phase.  Setting Depth to 
100% returns to full coast 
between brake pulses; setting 
Depth to 0% leaves braking force 
unchanged (this effectively 
disables ABS). 

Brake 
Time 

When ABS is engaged, time in 
seconds (0.1-5.0, default 1.0) 
during which brakes are applied 
at full strength 

 

 
 

 or  

Coast 
Time 

When ABS is engaged, time in 
seconds (0.1-5.0, default 1.0) 
during which brake pressure is 
reduced 

 
 

Failsafes 

 

You can set up the failsafe positions of the servos 
so that in the event of loss of signal, the servos go 
to their set failsafe positions. Default failsafe 
positions are centered steering and trim.  
 

You should always set your failsafe positions after 



making changes to your model, and should test 
your settings before driving. 

Setting Failsafe Modes 
 

Use the navigation controls to set the failsafe modes as follows: 

1. Access the top function menu 
from the driving screen. 

 

2. Navigate to the Advanced 
menu.   or      then   

3. Navigate to the Failsafe menu. 
  or      then   

4. Navigate to Steering. 
 or   

Value Description 
Hold Steering servo holds last known position. 

5. Change the steering servo 
failsafe setting. 

 or  Set Steering servo goes to set failsafe position. 

6. Navigate to Throttle. 
 or   

Value Description 
Hold Throttle servo holds last known position. 7. Change the throttle servo 

failsafe setting. Set Throttle servo goes to set failsafe position. 

8. Navigate to Channel 3. 
 or   

Value Description 
Hold Shift servo holds last known position. 9. Change the shift servo failsafe 

setting. Set Shift servo goes to set failsafe position. 

10. Navigate to Ch4. 
 

or  

  

11. Change the Ch4 servo failsafe 
setting.  or  

 Description  
Ch4 servo holds last known position. 
Ch4 servo goes to set failsafe position. 

 

Setting Failsafe Positions 
 

Use the navigation controls to set the failsafe positions as follows: 

Value
Hold 
Set 



1. Access the top function menu from the 
driving screen. 

 

2. Navigate to the Advanced menu. 
  or       then   

3. Navigate to the Failsafe menu. 
  or      then   

4. Navigate to Set Failsafes. 
 or   

5. At the confirmation screen: 
1. Select Yes to capture the servo 

failsafe settings. 
2. Select No to abandon the operation.  

 or  

6. Confirm your selection. 
 

7. A 3-second countdown begins on the display screen. 
 
Before the countdown ends, use the React controls to set the servo failsafe positions. (For example, on a nitro car set steering 
to centered and throttle to full brake.) 
 
At the end of the countdown, a confirmation message indicates that the servo failsafe positions were stored. 
 
8. To test the failsafe positions, turn off the React and observe the reactions of the connected servos.  The servos should go to 
the failsafe positions you just set. 
 
 

 
You should always set your failsafe positions after making changes to your model, and should test your 
settings before driving. An easy way to check the failsafe positions is to turn your model on before 
turning on the React. 

Speed 

 

The Speed display uses the tach sensor and 
several measurements you enter order to provide 
you with accurate speed readout. This is where 
you enter those measurements.  
 

The React must be programmed with distance in 
inches traveled per number of revolutions. The 
sensor then “does the math” in real time to 
provide you with a speedometer function that can 
be used for alerts. 
 

The two parameters that are used to make the 
Speed calculations are rollout and revolutions.  

 

 



Because the React cannot use fractions, it is necessary to find two whole numbers that represent shaft 
turns and wheel turns. There are two ways to do this. One involves math and the other involves 
physically measuring the car’s rollout. 

Calculation method 
The rollout can be calculated if you know the diameter of your tire and the gear 
reduction ratios between tachometer installation point and the wheels. If you are not 
sure of these ratios, you should probably use the Measurement method. 

Multiply tire diameter by PI (3.14159) to get length of one tire revolution.  

Multiply that by the gear reduction of your differential or transmission. The result is the 
number of inches your model will travel for each tick of the tach sensor.  

Convert that number to a fraction that can be input into the React. You can do this by 
multiplying the number by 200 or more and then rounding to the nearest whole 
number. So if your model travels 4.1242 inches per tach and you multiply by 500, the 
“rollout” number will be 2062.1, which rounds down to 2062, and the “revolutions” 
number will be 500. 

An Example: Your Model has 3.2” diameter tires.  Multiplying by pi results in 10.053” 
circumference.  Your Tach is mounted in front of a 13:5 gear reduction.  So, the model 
travels 10.053 x 5/13 = 3.8666 inches per tachometer.  This is approximately equal to 
116/30, so the rollout parameter should be set to 116, and the revolutions parameter 
should be set to 30. 

Measurement method 
In this method, you simply measure the distance traveled by your model over a short 
length and count the revolutions of your driveshaft. Due to the possibility of 
measurement errors, this method works best if you measure at least ten shaft 
revolutions. We recommend that you mark one of your magnets with a colored sharpie 
or piece of tape to reduce the risk of incorrect counting.  Make sure you are measuring 
using the same units (inches or centimetres) that the React is currently set up to use. 

Position your car against a wall with the wheels pointed straight ahead. The back end 
of the car should be touching the wall. 

Carefully watching the magnets on the shaft, roll the car forward until the shaft has 
rotated ten or more (more is better) times. The number of rotations will be your 
revolutions parameter. 

Measure from the wall to the back end of the car. If it should work out to an even 
number of inches or CM, that will be your rollout parameter. If your measurement is to 
the closest 1/8th of an inch, then in order to eliminate the fraction, you must multiply 
the revolutions by 8 and convert the length to 1/8th inches by multiplying the whole 
number of inches by 8 and then adding the number of extra 1/8ths. If you are using 
metric measurement, it is simple, just multiply CM length and rollout by ten.   



Example: Your model was measured to travel 31 5/8” in 10 drive shaft revolutions. 
This is equivalent to 31” x 8 + 5” = 253” in 80 revolutions.  Thus, the rollout 
parameter in should be set to 253, and the revolutions parameter should be set to 80 

The higher the numbers you use, the lower your error will be and the more accurate 
your speed will be. The maximum value that can be used is 10,000.  It may be more 
convenient to enter larger numbers using the Digital RC Desktop software. 

Since the tach sensor measures only shaft rotation, it does not take into account other 
issues like wheel spin, tire expansion at speed, cornering errors, etc.  

Tach (RPM) 

 

The RPM display uses the tach sensor and several 
measurements you enter order to provide you with 
accurate engine speed readout. This is where you 
enter those measurements.  
 

The React must be programmed with the gear 
ratio between the motor and the tach sensor. The 
React then “does the math” in real time to provide 
you with a tachometer function to monitor your 
engine speed. 
 

The two parameters that are used to make the 
Speed calculations are Motor Revs and Magnet 
Revs.  

Simply measure or calculate the gear ratio between the motor and your tach sensor. Enter the ratio in 
whole numbers (1-1000) using these two settings. 

Example #1:  If 4 revolutions of your motor or clutch bell makes your magnets rotate once your 
settings would be: 

Motor revs: 4 

Magnet revs: 1 

 
Example #2:  If 30 revolutions of your motor or clutch bell makes your magnets rotate 11 times your 
settings would be: 
Motor revs: 30 

Magnet revs: 11 
 

Example #3:  If your magnet is mounted in your spur gear and driven directly from the motor, set 
Motor Revs to the spur gear tooth count and Magnet Revs to the pinion gear tooth count. 

14 tooth pinion and 72 tooth spur would be: 
Motor revs: 72 



Magnet revs:14 

 
The motor must rotate 72 times for the Magnets to rotate 14 times. 

Tank Mode 

 

The Tank mode combines steering and throttle 
inputs to left-side and right-side drive.  Tank 
mode Uses Ch1 as right drive servo and Ch2 as 
left drive servo.  Throttle inputs affect both 
outputs equally. Steering input increases output on 
one side and decreases output on the other side. 
Mixing is applied after all other settings from both 
Ch1 and Ch2 (ABS, Autostart, both expo settings, 
etc). Servo travel is limited by Throttle/Brake 
endpoints. 

 

Activating / Deactivating Tank Mode 
Use the navigation controls to select the active model as follows: 

1. Access the top function menu from the driving screen. 
 

2. Navigate to the Advanced menu. 
  or      then   

3. Navigate to Tank Mode. 
 or   

4. Select On or Off. 
 or  

Using The Timer Function 
Use the Timer menu to configure, view on the drive screen to the left of Tx Bat. Default keys are:  

: Start/pause timers  

: Reset timers  

: Start a new lap  

: Restart pit timer countdown  
These keys only work on the drive screen, not in the menus. Other keys configurations 
can be set up with RC Desktop using  ”softkeys”. 

Model Management  
The following illustration shows the function menu structure for the model management functions: 



 

 

 

 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

Active Model 

 

The React can store all settings for up to forty 
vehicles. The Active Model function is used to 
select the model to be used. 
 

When you are connected to a transceiver, this list 
will only show models that apply to that 
transceiver.  When unconnected, all of the models 
stored on your transmitter will be shown in the 
list. 
 

When binding with a transceiver in a vehicle, you 
must first select the active model to identify the 
vehicle.  



 

When preparing to operate a vehicle, select the 
active model, then turn on the vehicle and React. 
The React searches for the transceiver with the 
VIN associated with the selected active model.  

 
For more information, see “The Binding Process” 
earlier in this manual.  

Selecting the Active Model 
 

Use the navigation controls to select the active model as follows: 

1. Access the top function menu from the driving screen. 
 

2. Navigate to the Manage Models menu. 
  or      then   

3. Navigate to Active Model. 
 or   

4. Select the active model. 
 or  

 

 
 

 
 

 

New Model 

 

You can create a new model settings profile if 
there are any model memories remaining. 
Creating a new model allows you to store the 
settings for another model.   
 

By default, the new model setting is given the 
number of the next highest model number (For 
example, if there are currently 4 model settings, 
creating a new model will create “Model 5” and 
make it the default model.) 
 



You can change the model name from your PC 
using the Digital RC Desktop. 

Creating a New Model 
Use the navigation controls to create a new model as follows: 

1. Access the top function menu from the driving 
screen. 

 

2. Navigate to the Manage Models menu. 
  or       then   

3. Navigate to and activate New Model. 
  or       then   

4. At the confirmation screen: 
3. Select Yes to create a new default model. 
4. Select No to cancel the operation.  or   

5. Confirm your selection. 
 

6. The “connecting” screen appears.   
You can press the “Menu” button to cancel.  
 

 
 

 

Delete Model 

 

You can delete a model settings profile. This 
removes all stored settings for the model from 
memory. 

Deleting a Model 
Use the navigation controls to delete a model as follows: 

1. Access the top function menu from the driving 
screen. 

 

2. Navigate to the Manage Models menu. 
  or      then   

3. Navigate to Active Model. 
 or   

4. Navigate to the model you want to delete. 
 or  



5. Navigate to and activate Delete Model. 
  or      then   

6. At the confirmation screen: 
5. Select Yes to delete the active model. 
6. Select No to cancel the operation.  or  

7. Confirm your selection. 
 

Copy Model 

 

You can copy settings from one model profile to 
create a new duplicate model. If all model profiles 
already exist, you cannot copy a model. 

Copying a Model 
Use the navigation controls to copy a model as follows: 

1. Access the top function menu from the driving screen. 
 

2. Navigate to the Manage Models menu. 
  or      then   

3. Navigate to Active Model. 
 or   

4. Navigate to the model for which you want to copy the 
settings.  or   

5. Navigate to and activate Copy Model. 
  or      then   

6. At the confirmation screen: 
7. Select Yes to create a new duplicate model. 
8. Select No to cancel the operation.  or  

7. Confirm your selection. 
 

8. A new duplicate model is created and set as active model. 

 

 
 

 



Rebinding 

 

You can rebind to the transceiver in a specific 
model (identified by a model profile). An example 
of when you might use this function would be if 
you replaced a transceiver on your car – you need 
to tell the React and the new transceiver to look 
for each other. 

 

 
 

 
 

 
 

 
 

 

Rebinding to a Model 
Use the controls to rebind to a model as follows: 

1. Access the top function menu from the 
driving screen. 

 

2. Navigate to the Manage Models menu. 
  or      then   

3. Navigate to Active Model. 
 or   

4. Navigate to the model you want to 
rebind with.  or  

5. Navigate to and activate Rebind. 
  or      then   

6. If the receiver was previously bound to a different React, turn on the model and perform the binding process again by 
activating the Bind button until the LED illuminates. Otherwise, just turn on the model. 
 

Controller Setup 
The following illustration shows the function menu structure for the controller setup functions: 



Vibrator 

 

As you might guess, this option lets you turn the 
vibration option on and off. 

Use the navigation controls to turn the vibrator on/off as follows: 

1. Access the top function menu from the 
driving screen. 

     

2. Navigate to the Controller Setup menu. 
  or      then   

3. Navigate to Vibrator. 
 or   

4. Turn the vibration option on/off. 
 or  

 
 

Contrast  

 

You can set the contrast of the display screen to 
make it lighter or darker for better visibility at 
your preferred viewing angle. 

Adjusting the Display Contrast Level  
Use the navigation controls to adjust the display contrast level as follows: 

1. Access the top function menu from the 
driving screen. 

 

2. Navigate to the Controller Setup menu. 
  or      then   

3. Navigate to Contrast. 
 or   

Value Description 
4. Adjust the display contrast level. 0 - 10 0 is lowest contrast level (faintest). 

10 is the highest contrast level (darkest). 
 



Units 

 

This option affects the display units for 
temperature (F/C), speed (MPH/KPH), and tach 
rollout (in/cm). 
 

Note:  Changing this setting does not convert 
existing temperature and speed alerts, nor tach 
rollout to the new units.  You must go through and 
reset those settings manually after a conversion. 

 
 

 
 

Selecting Unit System  
Use the navigation controls to adjust the display contrast level as follows: 

1. Access the top function menu from the 
driving screen. 

 

  

2. Navigate to the Controller Setup menu. 
  or      then   

  

3. Navigate to Units. 
 or   

  

4. Select which units system to use. Value Description   
 
 

 

 

 
 

Calibrate  

 

This function allows you to recalibrate the React 
steering and throttle controls. It does not change 
any of the steering or throttle settings that are 
stored in the model profiles. 

Recalibrating the React 
Use the navigation controls to recalibrate the React as follows: 



1. Access the top function menu from the 
driving screen. 

 

2. Navigate to the Controller Setup menu. 
  or       then   

3. Navigate to and activate Calibrate. 
  or       then   

4. At the confirmation screen: 
9. Select Yes to recalibrate  
10. Select No to cancel the operation  or   

5. Confirm your selection. 
 

6. Perform the calibration routine by following the on-screen commands. Only move one control at a time, as directed by the 
prompts, leave the other control centered in its hands-off position.  
 

For best results, pull the trigger then gently release it before starting calibration. After calibrating the 
brake travel, gently release the trigger. This will ensure that any mechanical dead zone in the trigger is 
properly detected. 

About 

 

The About screen displays the version number and 
ID number for your React. 
 
If you are connected to a transceiver the version 
number and VIN for the transceiver are also 
shown. 

 
This function also displays your startup screen and 
user name. This is a great way to show off your 
customized graphics to your friends! 

 

Viewing the React About Screen 
Use the navigation controls to view the about screen as follows: 

1. Access the top function menu from the 
driving screen. 

 

2. Navigate to the Controller Setup menu. 
  or       then   

3. Navigate to and activate About. 
  or       then   

4. View the startup screen and user name, then 
press OK.  



5. View the versions and IDs, then press OK. 
 

 

React Digital RC Desktop 
 

 

The innovative React Digital RC Desktop can be used to program the functionality of your 
React using your computer. The supplied adaptor cable is used to connect your React to 
an available USB port on your computer, allowing your React and the RC Desktop to 
communicate and exchange information. The RC Desktop interface has the same menu 
structure as that contained within your React; and has been designed to be very easy to 
use. 

Information may be transferred between your React and the RC Desktop so that you can 
download your current setting information to your computer, make changes, and then 
upload the newer settings.  Updating the React firmware is as easy as uploading a file, or 
using your Internet connection to retrieve the latest firmware file directly from Nomadio 
and upload it to your React in one easy step. 

After you start using your React and install your RC Desktop, we strongly recommend that 
you perform the registration process so that you can receive special incentives and 
privileges, and be kept abreast of the latest Nomadio developments and news. The online 
registration process is fast and easy, and requires an Internet connection.   

Minimum System Requirements 
 

Processor Pentium 3 
Ram 128MB 
HDD space 100MB 
Display VGA or better 
Ports Available USB port (1.1 or 2.0 port 

recommended) 
OS Windows 2000, XP 

Installing the RC Desktop 



 
3.When the installation begins you will be presented with a Setup Wizard that begins with the Nomadio 
License Agreement.  Click I Agree to continue. 

 
4.Next choose the destination folder for the Digital RC Desktop by either typing in the path or clicking 
the Browse button and picking the folder you wish to use.  Click the Next button to continue 



 
5.At the next screen, select the Start Menu folder for the Digital RC Desktop’s shortcuts.  Click the Do 
not create shortcuts checkbox if you do not want shortcuts created.  Click Install to continue the Setup 
Wizard. 

 



 
10.Digital RC Desktop Setup is now almost done.  Click Next to continue. 

 
11.Leave the Run Nomadio Digital RC Desktop now? checkbox selected for the Setup Wizard to 
launch the program after exiting the Setup Wizard.  Click Finish to exit the Nomadio Digital RC 
Desktop Setup. 



Connecting the React to your Computer 
 

To connect your React to your computer, do the following: 
1. Open the battery compartment 

 

2. Plug the smaller end of the included USB cable into the cable with the matching USB connector 
inside the React’s battery compartment. 
3. Turn on your React. (note that if your battery is dead, it will power off the USB port when you 
plug in. Do still put the switch in the On position.  Your computer will recognize the React as being 
connected and will likely make a beeping noise. Run RC Desktop to send and receive settings. 

To use your React as a gaming controller, follow the same instruction except make sure 
the React is turned off. 

 
 

 
 

 

 

 
 

 
 

 

Using the React Digital RC Desktop 



 
To start the RC Desktop From the START menu, click (All) Programs, Nomadio Digital RC Desktop, then 

Nomadio Digital RC Desktop. 
To make changes to the 
settings 

Navigate through the functions of the RC Desktop, and make changes as appropriate to 
global settings, or to settings for individual models. 

To open a saved settings file From the File menu, click Open…. 
To save the current settings 
into a file 

From the File menu, click Save. 

To create a new model From the File menu, click Create New Model, or right click on the file name at the top of 
the tree on the left, and select Create New Model. 

To copy a model In the tree on the left, right click on the model that you wish to copy.  On the popup menu, 
select Copy Model.  A new model will be created that is a copy of the selected model 
(though the name is not copied) 

To delete a model In the tree on the left, right click on the model that you wish to copy.  On the popup menu, 
select Delete Model.   

To receive the current 
settings from the React 

1. Connect the React to your computer. 
2. Turn on the React. 
3. From the Connection menu, click Receive Settings from React. 

To send the RC Desktop’s 
current settings to the React 

1. Connect the React to your computer. 
2. Turn on the React. 
3. From the Connection menu, click Send Settings to React. 

To install the latest firmware 
into the React  

1. Connect the React to your computer. 
2. Turn on the React. 
3. From the Connection menu, click Install Latest React Firmware. 

To update the RC Desktop to 
the latest version 

From the Help menu, click Software Updates. 

Registration 
 

1.When you start the Digital RC Desktop the first time, you will be prompted to register.  Click Yes to 
continue.  If you click No, you can register you will be prompted again the next time you start the 
Digital RC Desktop.  You can register immediately by choosing the Help menu and then choosing 
Register new React 

.  
2.The Digital RC Desktop will now read your React’s ID.  Connect your React and click OK. 



 
3.Your web browser will then be opened to a web page that will ask you for registration information.  
Your React ID will be automatically read from your React and filled in. 
4.When you click the Register button, a confirmation e-mail will be sent to you.  This will e-mail will 
contain a link back to Nomadio’s registration site where you will be able to get your registration code. 

 
5.Enter your registration code in the Digital RC Desktop and click the OK button.  If you press Cancel, 
you can enter your registration code by choosing the Help menu and choosing Enter Registration Code. 



 
6.You are now registered. 

Registering a Second Computer 
If you wish to register a second computer (for example, a laptop you take to the track, your work 
computer, etc) simply repeat the installation and registration process using the same email address. 
If you encounter problems or no longer have access to the email address you used to register send an 
email to support@nomadio.net. 

Receiving Settings From the React 

 
The Digital RC Desktop will attempt to receive settings from the React on startup.  You can also 
choose the Connection menu and then choose Receive Settings from React.  Finally you can choose the 
Receive Settings From React toolbar button. 

1.The Digital RC Desktop will then connect to your React and download the settings from it. 

Editing Settings 
 



 
Simply use the settings menu on the left side of the screen to find the settings you wish to edit.  
Individual settings appear in the right side of the screen.  Changes can be saved to a file on your PC 
and/or sent to the React. 



Using Softkeys 

 
 

 
 

 
 

 
 

 
 

 
 

 

 

 
 

 
 



Softkeys allows you to choose the function of the button and trims on the React. Click on the pull down 
button and choose the function you would like that button or trim tab to 
control.

 

Saving Settings 

 
Settings can be saved by choosing the File menu and choosing either Save or Save As… .  Choosing 
Save saves the settings to the current file name.  Choosing Save As… lets you pick a file name.  You 
can also save your current settings use the Save and Save As toolbar buttons.  If you forget to save and 
then try to exit the Digital RC Desktop, you will be prompted to save. 

Sending Settings to the React 

 
You can send your settings to the React by choosing the Connection menu and then choosing Send 
Settings to React.  You can also send your settings by choosing the Send Settings to React toolbar 
button.  If you forget to send your settings to the React after editing them, the Digital RC Desktop will 
prompt you to send your settings on exit. 

Installing React Firmware 
 

To install new React Firmware, choose the Connection menu and then choose Install Latest React 



Firmware.  If you have been instructed to update your transceiver(s) also, you will need to connect the 
transceiver to the React using the Receiver Programming Cable inside the battery compartment. That 
cable should plug into the “TACH” port on your transceiver. Once you are connected, select Install 
Latest Transceiver Firmware.  

Specifications 
Specifications subject to change without notice. 

React Controller 
Radio Type: digital spread spectrum 2.4Ghz 
Radio Mode: direct sequence (DSSS) and frequency 
hopping (FHSS) spread spectrum 
Range: 1000ft. (approximate) 
Frame Rate: 100 frames per second 
Latency: 10 millisecond max, 5ms typical 
Dimensions: 300mm x 139mm x 125mm (HWD) 
Weight (w/Batteries): 674g 
Servo Channels: 4 
Rechargeable Batteries: NiMH (included) 
Controller Battery Voltage Monitor: graphic and real-
time 
Car Battery Voltage Monitor: graphic and real-time 
Timers: operation and lap timers 
Trims: adjustable trims and sub-trims 
Controls: dual rate, endpoints, exponential, mixing 
and servo speed adjust on all channels 
 

Anti-Lock: brake anti-lock with cycle, delay, and depth 
Idle Up: yes 
Tactile Alarm: programmable vibrator 
Resolution: 128 x 64 pixels 
Auto Modes: auto display and display only 
Presets: failsafe and autostart 
Telemetry: 3 channels of real time telemetry 
Telemetry Sensors: speed, temperature and battery 
Servos Supported: any combination of analog and 
digital 
PC Connectivity: USB serial for customization, 
analysis and updates 
Antenna: Internal 
Architecture: software upgradeable 
 

 

Transceiver 
 

Dimensions: 47.7 x 30.2 x 19mm  
Weight: 34g (including antenna) 

Antenna length: 22.8cm 
Antenna thickness: 1.8mm 

 
 

Support 
 

Nomadio is committed to providing the best support in the RC market for its products. If you have any 
issues with your React, please visit our support website at 
http://support.nomadio.net 



 
There you will find a wealth of knowledge from other React users as well as Nomadio’s support staff. 
Should you need to contact Nomadio directly web support staff will give you the information necessary 
to get you running.  
 



 
 
 
 

 
 

 



Statement of Compliance 

FCC Compliance Statement 
This equipment has been tested and found to comply with the limits for a Class B digital device, 
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference in a residential installation. This equipment generates, uses and can radiate 
radio frequency energy and, if not installed and used in accordance with the instructions, may cause 
harmful interference to radio communications. However, there is no guarantee that interference will not 
occur in a particular installation.  
If this equipment does cause harmful interference to radio or television reception, which can be 
determined by turning the equipment off and on, the user is encouraged to try to correct the interference 
by one or more of the following measures: 

Reorient or relocate the receiving antenna. 
Increase the separation between the equipment and receiver. 
Connect the equipment into an outlet on a circuit different from that to which the receiver is 
connected. 
Consult the dealer or an experienced technician for help. 
This device complies with Part 15 of the FCC Rules and with RSS-210 of Industry Canada. Operation 
is subject to the following two conditions: 

11. this device my not cause harmful interference, and 
12. this device must accept any interference received, including interference that may 

cause undesired operation. 
 

Warning: Changes or modifications made to this equipment not expressly approved by Nomadio may 
void the FCC authorization to operate this equipment. 

RF Exposure Statement 
This transmitter has been tested and meets the FCC RF exposure guidelines when used with the 
Nomadio accessories supplied or designated for this product, and provided at least 20 cm separation 
between the antenna and the user’s body is maintained. Use of other accessories may not ensure 
compliance with FCC RF exposure guidelines. 

Modular Approval Statement 



If you install the React transceiver inside of a vehicle, and you are not the final end user, FCC 
regulations require you to make the React transceiver’s FCC ID easily visible to the end user. In order 
to do this, please, print the image below onto a permanent sticker, and place it in a visible location such 
as on the bottom of the vehicle (a pre-printed sticker is provided in the package): 

Racing Association Approvals 
The React system has been approved for competitive use by the following racing organizations. In 
many cases, the use of telemetry is prohibited or regulated, please consult your race director for details. 
For an updated list, please consult the Nomadio support website, where a current list is always 
maintained: 

ROAR 
EFRA 

IFMAR 
QSAC 

 

React and its software are designed and manufactured in the United States of America. 
 

Nomadio 1 Year Limited Warranty 
 

Warranty Coverage  
Nomadio’s warranty obligations are limited to the terms set forth below:  
Nomadio, as defined below, warrants this Nomadio-branded hardware product against defects in 
materials and workmanship under normal use for a period of ONE (1) YEAR from the date of retail 
purchase by the original end-user purchaser (“Warranty Period”). If a hardware defect arises and a 
valid claim is received within the Warranty Period, at its option, Nomadio will either (1) repair the 



hardware defect at no charge, using new or refurbished replacement parts, or (2) exchange the product 
with a product that is new or which has been manufactured from new or serviceable used parts and is at 
least functionally equivalent to the original product, or (3) refund the purchase price of the product. 
Nomadio may request that you replace defective parts with new or refurbished user-installable parts 
that Nomadio provides in fulfillment of its warranty obligation. A replacement product or part, 
including a user-installable part that has been installed in accordance with instructions provided by 
Nomadio, assumes the remaining warranty of the original product or ninety (90) days from the date of 
replacement or repair, whichever provides longer coverage for you. When a product or part is 
exchanged, any replacement item becomes your property and the replaced item becomes Nomadio’s 
property. Parts provided by Nomadio in fulfillment of its warranty obligation must be used in products 
for which warranty service is claimed. When a refund is given, the product for which the refund is 
provided must be returned to Nomadio and becomes Nomadio’s property.  
 

 

Exclusions and Limitations 
This Limited Warranty applies only to hardware products manufactured by or for Nomadio that can be 
identified by the “Nomadio” trademark, trade name, or logo affixed to them. The Limited Warranty 
does not apply to any non-Nomadio hardware products or any software, even if packaged or sold with 
Nomadio hardware. Manufacturers, suppliers, or publishers, other than Nomadio, may provide their 
own warranties to the end user purchaser, but Nomadio, in so far as permitted by law, provides their 
products “as is”. Software distributed by Nomadio with or without the Nomadio brand name 
(including, but not limited to system software) is not covered under this Limited Warranty. Refer to the 
licensing agreement accompanying the software for details of your rights with respect to its use.  
 
Nomadio does not warrant that the operation of the product will be uninterrupted or error-free. 
Nomadio is not responsible for damage arising from failure to follow instructions relating to the 
product’s use.  
 
This warranty does not apply: (a) to damage caused by use with non-Nomadio products; (b) to damage 
caused by accident, abuse, misuse, flood, fire, earthquake or other external causes; (c) to damage 
caused by operating the product outside the permitted or intended uses described by Nomadio; (d) to 
damage caused by service (including upgrades and expansions) performed by anyone who is not a 
representative of Nomadio or an Nomadio Authorized Service Provider; (e) to a product or part that has 
been modified to significantly alter functionality or capability without the written permission of 
Nomadio; (f) to consumable parts, such as batteries, unless damage has occurred due to a defect in 
materials or workmanship; or (g) if any Nomadio serial number has been removed or defaced.  
 
TO THE EXTENT PERMITTED BY LAW, THIS WARRANTY AND REMEDIES SET FORTH 
ABOVE ARE EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES, REMEDIES AND 
CONDITIONS, WHETHER ORAL OR WRITTEN, STATUTORY, EXPRESS OR IMPLIED. AS 
PERMITTED BY APPLICABLE LAW, NOMADIO SPECIFICALLY DISCLAIMS ANY AND ALL 
STATUTORY OR IMPLIED WARRANTIES, INCLUDING, WITHOUT LIMITATION, 
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
WARRANTIES AGAINST HIDDEN OR LATENT DEFECTS. IF NOMADIO CANNOT 
LAWFULLY DISCLAIM STATUTORY OR IMPLIED WARRANTIES THEN TO THE EXTENT 
PERMITTED BY LAW, ALL SUCH WARRANTIES SHALL BE LIMITED IN DURATION TO 



THE DURATION OF THIS EXPRESS WARRANTY AND TO REPAIR OR REPLACEMENT 
SERVICE AS DETERMINED BY NOMADIO IN ITS SOLE DISCRETION.  
No Nomadio reseller, agent, or employee is authorized to make any modification, extension, or 
addition to this warranty.  
 
EXCEPT AS PROVIDED IN THIS WARRANTY AND TO THE EXTENT PERMITTED BY LAW, 
NOMADIO IS NOT RESPONSIBLE FOR DIRECT, SPECIAL, INCIDENTAL OR 
CONSEQUENTIAL DAMAGES RESULTING FROM ANY BREACH OF WARRANTY OR 
CONDITION, OR UNDER ANY OTHER LEGAL THEORY, INCLUDING BUT NOT LIMITED TO 
LOSS OF USE; LOSS OF REVENUE; LOSS OF ACTUAL OR ANTICIPATED PROFITS 
(INCLUDING LOSS OF PROFITS ON CONTRACTS); LOSS OF THE USE OF MONEY; LOSS OF 
ANTICIPATED SAVINGS; LOSS OF BUSINESS; LOSS OF OPPORTUNITY; LOSS OF 
GOODWILL; LOSS OF REPUTATION; LOSS OF, DAMAGE TO OR CORRUPTION OF DATA; 
OR ANY INDIRECT OR CONSEQUENTIAL LOSS OR DAMAGE HOWSOEVER CAUSED 
INCLUDING THE REPLACEMENT OF EQUIPMENT AND PROPERTY, ANY COSTS OF 
RECOVERING, PROGRAMMING, OR REPRODUCING ANY PROGRAM OR DATA STORED 
OR USED WITH NOMADIO PRODUCTS AND ANY FAILURE TO MAINTAIN THE 
CONFIDENTIALITY OF DATA STORED ON THE PRODUCT. THE FOREGOING LIMITATION 
SHALL NOT APPLY TO DEATH OR PERSONAL INJURY CLAIMS. NOMADIO DISCLAIMS 
ANY REPRESENTATION THAT IT WILL BE ABLE TO REPAIR ANY PRODUCT UNDER THIS 
WARRANTY OR MAKE A PRODUCT EXCHANGE WITHOUT RISK TO OR LOSS OF THE 
PROGRAMS OR DATA.  
 

Consumer Protection Laws 
  
FOR CONSUMERS WHO ARE COVERED BY CONSUMER PROTECTION LAWS OR 
REGULATIONS IN THEIR COUNTRY OF PURCHASE OR, IF DIFFERENT, THEIR COUNTRY 
OF RESIDENCE, THE BENEFITS CONFERRED BY THIS WARRANTY ARE IN ADDITION TO 
ALL RIGHTS AND REMEDIES CONVEYED BY SUCH CONSUMER PROTECTION LAWS 
AND REGULATIONS. Some countries, states and provinces do not allow the exclusion or limitation 
of incidental or consequential damages or exclusions or limitations on the duration of implied 
warranties or conditions, so the above limitations or exclusions may not apply to you. This warranty 
gives you specific legal rights, and you may also have other rights that vary by country, state or 
province. This Limited Warranty is governed by and construed under the laws of the country in which 
the product purchase took place. Nomadio, the warrantor under this Limited Warranty, is identified at 
the end of this document according to the country or region in which the product purchase took place.  
 
 

Obtaining Warranty Service  
Please access and review the online help resources referred to in the documentation accompanying this 
hardware product before requesting warranty service. If the product is still not functioning properly 
after making use of these resources, please contact the Nomadio representatives or, if applicable, a 
Nomadio Authorized Service Provider located using the information provided in the documentation. 
An Nomadio representative or Nomadio Authorized Service Provider will help determine whether your 



product requires service and, if it does, will inform you how Nomadio will provide it. Nomadio or its 
Nomadio Authorized Service Providers will provide warranty service on products that are tendered or 
presented for service during the Warranty Period, as permitted by law. If the purchaser is outside the 
United States, service will be limited to the options available in the country where service is requested. 
Warranty service may be restricted to the country where the product is purchased. Service options, 
parts availability and response times will vary according to country. You may be responsible for 
shipping and handling charges if the product cannot be serviced in the country it is in. In accordance 
with applicable law, Nomadio may require that you furnish proof of purchase details and/or comply 
with registration requirements before receiving warranty service. Please refer to the accompanying 
documentation for more details on this and other matters on obtaining warranty service.  
 
If your product is capable of storing data or software programs, you should make periodic backup 
copies of the data and programs contained on the product’s storage media to protect your data and as a 
precaution against possible operational failures. Before you deliver your product for warranty service it 
is your responsibility to keep a separate backup copy of your user data, and disable any security 
passwords. Repaired products will be returned to you in factory-fresh condition. You will be 
responsible for reinstalling all such data and passwords. Nomadio and its Authorized Service Providers 
are not liable for any damage to or loss of any data, or other information stored on any media, or any 
non-Nomadio product or part not covered by this warranty. Recovery and reinstallation of user data are 
not covered under this Limited Warranty.  
 



 


